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Section 1. Installation

To assist you with the installation of this software an installation
program INSTALL.EXE is included on your distribution disk. This program
MUST be used for the various files required to be installed properly.

To install FileMan insert the distribution disk in either drive A: or drive

B:. If the disk is in drive A: type

A:INSTALL

at the dos prompt. If the disk is in drive b: type

B:INSTALL

During the installation process you may abort the installation at any
time by pressing Escape.

The first step is to enter the company or owners name. This must
consist of more than three non blank characters. This name will be displayed
in the About FileMan screen and will be included in the page header of your
printouts.

Next you will be asked to enter the serial number which appears on the
disk label. Type this exactly as it appears on the label.

Now you must specify what drive and directories the program should
be installed in. The defaults are drive C: in directories \FILEMAN and
\FILEMAN\DATA. After entering the necessary data Install will create the
destination directories if they do not already exist, and will then begin copying
files to your hard drive.

If a necessary file can not be found FileMan will display a prompt
asking you to switch disks or enter a pathname where the required files may be
found. Insert the appropriate disk and press Enter.

After copying all necessary files you will have the opportunity to set up
your printer. FileMan uses the DOS print spooler to allow you to continue
working while data is being printed. The DOS print spooler should be installed
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at boot time by placing it in your AUTOEXEC.BAT file. The installation
program will do this for you if you choose.

After performing the above steps setup information will be displayed

and the install program will finish.

When you install FileMan a batch file is created with the name
FM.BAT. It will automatically contain the proper options based on how you
choose to install FileMan. This batch file should then be used to start FileMan.
FM.BAT can be placed in a directory included in your DOS PATH,orit orits
contents may be entered into any menu programs you are currently using.

Install will display a list containing the directories included in your PATH
variable. You should select one of these directories (preferably one near the top
of the list) for the location ofthe batch file. The program should now be started

by typing FM.

It is possible that you may already have a program named FM on your
computer. If this is true you can rename the FM.BAT file to another name
which you find convenient such as FM48.BAT. You must preserve the .BAT
extension. This batch file is provided so that you do not need to add the
FileMan directory to your DOS path or type any command line options used by
FileMan. It is only necessary that the FM.BAT file is installed in a directory
which is included in your DOS path and you will be able to run FileMan from
any directory or drive on your system by typing FM.

Section 1.1. Advanced Installation

FileMan is intended for use on computers which are equipped with at
least one hard disk. It may be possible to use the programs from floppy disk
but performance will suffer. For this reason using FileMan from floppy disk
is neither recommended nor supported.

FileMan requires 640K RAM to be fully functional. With less RAM
available you will have to work with smaller files and configuration will be

more difficult.

The FileMan program supports the optional use of a mouse or other
pointing device. If you have a mouse and the necessary drivers installed
FileMan will detect this and display a mouse pointer and you will be able to
control the software with the mouse.
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The FileMan program also supports the 8087 family of numeric
coprocessors. If you do not have a coprocessor installed then FileMan will

detect this and perform numeric computations in software.

If you are using a monochrome monitor and video card FileMan will
detect this and adjust the screen coloring appropriately.

When FileMan is installed two directories are created. The first
contains the program files and various other files created by FileMan.
Throughout this manual this is referred to as the home directory.

The second directory which will be created is the data directory. By

default this will be a subdirectory of the home directory named 'DATA’. When
the FileMan program is started the data directory may be specified on the
command line if you wish to use a directory other than the default. A typical
example is:

fileman /D\fileman\mydata /Se:\fileman.vm

FileMan provides several command line options which may be used to
customize your installation. All command line options are of the form
/X <value> where X specifies the option and <value > specifies a value for
the option. The options currently available are:

/D < data directory > Defines what data directory to use. Default is
\FILEMAN\DATA.

/T <temp directory > Specify location of temporary print spooling files.

/U <user name > Specify user name.

/S < swapfile name > Defines path for FileMan’s swapfile. Default is
FILEMAN.VM.

/P <pages> Specify number of pages of virtual memory to be
used. Default 1s 1000.

/F < frames > Specify number of virtual memory frames to be used.
Default is 100.
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/C Specify name of configuration file. Default is
FILEMAN.CFG in the directory FileMan is installed
in. This option allows you to save multiple
configuration files, or allows you to use a separate
configuration file for each workstation when installed
on a network.

1? Displays FileMan version information and valid
command line options.

If you should decide to edit the FM.BAT file you must follow this format.

If you wish to use a data directory other than \FILEMAN\DATA you
can specify this directory name with the data option. FileMan will then run in
this directory by default.

FileMan uses a swap file to provide virtual memory. Virtual memory

is memory which does not physically exist but is simulated by moving data from
disk to RAM as needed. This allows FileMan to work with larger amounts of
data than could be loaded into your computer at one time. Once a file exceeds
the size which can fit in RAM, parts of it are moved to disk as necessary to
maintain enough free RAM to operate.

To optimize performance the swap file should be placed on the fastest
drive available. A RAM drive would be suitable for this purpose. For
information on RAM drives see your DOS manual. Another way to increase
performance is by using a disk caching program such as SMARTDRYV, included
with Microsoft DOS 5+ and Microsoft Windows.

The swap variable allows you to specify the path and name of
FileMan’s swap file. The main purpose of this is to allow you to locate the
swap file on a different drive from the one your data files are stored on. If not
specified the default is the root directory of the drive containing FileMan. If
FileMan is installed on a network drive, specifying a local drive for the swap
file will decrease network traffic, possibly increasing performance.

There are two more command line options which affect the usage of
virtual memory. They are the Pages’ and 'Frames’ variables. These allow you
to customize the memory and disk allocation of FileMan. If you are familiar
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with memory management techniques you may wishto optimize your systemthis
way.

If you have a shortage of disk space you can specify a smaller value for
the pages variable to reduce the size of the swap file. Reducing this value will
reduce the maximum number of points per file. The maximum number of

points is equal to 10 * pages.

If you find yourself running out of RAM while using FileMan you may
wish to reduce the number of virtual memory frames. A shortage of RAM is
indicated by receiving Not enough memory to complete operation’ error
messages or you can see the free RAM in the Options System Info dialog box.
Reducing the number of frames will make more RAM available for other
purposes but it will also require FileMan to swap more often, slowing operation.
This will not be significant if you have a good disk caching program running.
The number of points which can be held in memory before swapping becomes
necessary is equal to 10 * frames.

FileMan also recognizes certain DOS environment variables. DOS
environment variables are set and examined using the DOS SET command. For

more information on the SET command see your DOS manual.

The environment variables which are used by FileMan are:

TEMP The TEMP variable has the same effect as the /T command

line parameter.

USER The USER variable has the same effect as the /U command

line option.
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Section 1.2. Network Installation

FileMan48 may be installed on a network however certain precautions
must be observed. These precautions all relate to the possibility of more than
one person attempting to access a file at the same time. The most obvious
example of this is if two people load the same data file at the same time. No
errors will occur however this creates what is known as a race condition. If
both users modify the file and save it only the changes made by the last user
to save will exist on disk. Therefore, if you will install FileMan on a network

drive where more than one person may use it you must exercise caution.

A conflict will also occur if you use the default value for the swap file.
This is why we recommend keeping the swap file on a local hard drive if
possible. If you will have multiple users using FileMan simultaneously, you
must specify a unique TEMP directory and swap file for each machine. See the
previous section for options to perform both these functions.

By specifying a unique TEMP directory and swap file name for each
machine (preferably on a local hard drive), conflicts among FileMan’s system
and temporary files may be avoided. Users still must continue to exercise care
with regard to modification of data files.

10
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Section 1.3. Changes From Previous Versions

Version 3.3 of FileMan is visibly quite different from previous
versions. In spite ofthis it is compatible with earlier version 3 releases. Most
of the changes are restricted to the user interface. Some important differences
are:

The organization of the menus has been revised with the addition ofthe
Cogo and Window pulldown menus.

An Area computation routine has been added.

RPN calculator functions have been enhanced.

Cogo files are now displayed and stored with 5 decimal places.

If the Insert Zero Points option is disabled, only Cogo points which
contain data are inserted in the file when importing or reading from the
HP48. Enabling this option corresponds to the way previous versions
of FileMan operate.

Gradeline file printouts contain additional data such as crest/sump
stations and elevations.

You may open more than one file at a time. However the maximum
points limit now applies to all files open simultaneously.

The Transfer Test ASCII Format command allows you to quickly check

the format of an ASCII Cogo file you wish to import.

Memory usage is optimized to allow the fastest access with small files.
As file size increases FileMan becomes increasingly frugal with
memory, to allow largerfile sizes, but with a loss in loading time.

To select an item from the main menu you must type Alt+C where C

is the highlighted character in the menu item.

For more information on changes to the user interface see Section 3 of
this manual, Using FileMan.

11
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Section 2. Introduction To FileMan

Fileman48 is designed to work in conjunction with RAMSS’ Party
Chief surveying software for the HP48 handheld computer. The main purpose
of this package is to provide an easy to use database for storage of surveying
data. This program also provides a way oftransferring data between the HP48
and other PC based surveying software. FileMan is capable of reading and
writing ASCII files to communicate with these programs.

Section 2.1. File Formats

The FileMan database provides a powerful tool for organizing and
manipulating surveying data. FileMan currently can work with six types of
files. If you purchased the Basic version of FileMan then you can work with
Cogo files only.

Allthe file types are organized in a similar manner. Data is stored on
a point by point basis where points are referenced by a name. This name may

consist of an optional prefix and a number. It is limited to an overall length of
10 characters. The prefix may be from 0 to 5 characters in length. The name
also may not contain any spaces. Names of less than 10 characters will be right
justified when displayed but these spaces are not significant.

Another consideration is that point names are treated as a combination
of an alphanumeric string and a number - therefore all of the following refer to
the same point:

pt1’  ’pt001’  ’pt00001°

For reasons discussed later, the first method, without leading zeros should be

used in most cases.

Point prefixes are case sensitive. Therefore capital letters are
considered as different characters from lowercase letters. For this reason the
following names all refer to different points:

'pt9999°  °Pt9999°  °PT9999’  ’pT9999’

This distinction allows the creation of a greater variety of point name prefixes

than would otherwise be possible.

12
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If you wish to remain compatible with some other software which does
not recognize lowercase characters it may be advisable to use only uppercase
characters. This can be accomplished by working in FileMan with CapsLock

on. If your software allows point numbers only, this can be done by leaving the
prefix field empty.

Files are maintained with all points stored in sorted order. Whenever
new points are added they are automatically inserted into the proper location.
This sorting process also ensures that point names are not duplicated within the
file. If you attempt to manually insert a new point and use a duplicate point
name you will receive a "Duplicate Point Error" message and the point will not
be inserted. If you load a file which has been edited by hand or was not
generated by FileMan you may also see this error.

Each file also contains information about the date and time of last
modification, the person who modified it, and the place where it is stored.

13
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Section 2.2. Cogo Files

Thefirst file type used by FileManis called the Coordinate Geometry
or Cogo file. It is a collection of points in a three dimensional space.
Associated with each point are three numeric values ( a north coordinate, an east
coordinate, and an elevation ) and a line of text ( a note ). These four fields

contain all the data associated with the point. The point also has an

alphanumeric name by which it is referenced.

The north and east coordinates, and the elevation are allocated five

decimal places. Less significant digits are rounded off when stored in a data
file.

The text may be as long as 24 characters and any printable characters
other than control characters such as carriage return and line feed are

permissible. Because of the design of the HP48 double quotation marks (") can
not be included in the data downloaded to Party Chief. If this character appears
in any points downloaded to Party Chief it will be replaced with the grave accent
(‘). Please note that this is not the single quotation or apostrophe (’).

FileMan recognizes certain line and symbol codes when included in the
text field. When FileMan is used to process Topo files the feature coding is
preserved here to allow FileMan to plot the lines and symbols collected. This
numeric code placed at the beginning ofthe text field should be separated from
any additional text by a space. For more information on the coding, see the
Topo Collection section of the Party Chief manual.

14
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Section 2.3. Topo Files

FileMan also uses Topo files to store topography data. These files
contain raw data and store points in the format in which they are collected.

Each point contains eight fields in addition to the point name. These
include the horizontal angle, zenith angle, slope distance, rod height, and four

other fields which store various codes associated with the point. FileMan also
has the ability to reduce these raw Topo files to Cogo files, preserving the
feature coding in the text field. For more information on the Topofile structure
and the feature coding see the appropriate section of the Party Chief manual.

When displaying and printing Topo files you may choose from the
following display formats:

Hor. angle, Ver. angle, Slope distance

Hor. angle, Zen. angle, Slope distance

Hor. angle, Hor. dist. Ver. distance

15
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Section 2.4. Highway Design Files

FileMan works with three additional file types known collectively as
Highway Design Files. These include Baseline, Gradeline, and Template file
types. These files provide a more orderly way to store and reference certain
types of data.

The Baseline (previously known as Stake)file type provides horizontal
alignment data for roads and utilities. A small Baseline file can provide all the

data needed for miles of roads or utilities. From this information any

coordinates needed can be computed.

The Gradeline (previously known as PGL) file provides vertical
alignment data for roads and utilities. In conjunction with Baseline files this
allows you to precisely locate roads and utilities in a 3D coordinate system.

The Template file type allows you to specify a typical section of a road
or other feature, and then generate coordinates for any location on the template.
Templates are used in conjunction with Baseline and Gradeline files.

For more information on these file types see the appropriate section of

the Party Chief manual.

16
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Section 2.5. Gradesheet Files

The Gradesheet file type allows you to record the process of staking

out. It enabled you to review your days work, seeing what stakes were set and

where they were placed. This information may be printed out in two ways: a
short version intended to be given to contractors and inspectors, and the full
report which includes additional information for use in your office. See the
Print section for additional information onthis feature. The use of Gradesheet
files is covered in depth in the Party Chief manual.

Currently, Gradesheet files may only be read from the HP48. It is not

possible to write a Gradesheet file to the HP48.



FileMan48 Version 3.3

Section 3. Using FileMan

This section explains the basics of using the FileMan program in an
order designed to allow you to follow along on the computer.

In general FileMan functions in the same way regardless of the file type
with which you are working. All the following instructions will refer to Cogo

files except where otherwise noted.

Even using virtual memory as described in the Installation section it is
necessary to place a limit on data file sizes. Currently FileMan has a maximum
file size of 10,000 points. It should be noted however that as file sizes increase
performance will decrease. Forthis reason you should consider breaking large
files apart into logical units which can be handled more efficiently. Thisis also
a safer alternative because should a file be corrupted you will not lose such a
large amount of data.

18
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Section 3.1. Manual Notation

Several conventions are used throughout this manual.

The words ’Enter’, ’Space’, ’Tab’, and ’Escape’ are used to

indicate that you should press the corresponding key on the

keyboard.

The letter ’F’ followed immediately by a number such as F8 denotes
Function Key 8.

When you should press two keys at the same time they are written

with a plus sign between them. For example press Alt+X to exit
the program.

Commands are named by the complete command string required to
execute them. For example to execute the File Open command you
would press Alt+F to select the File Menu, then press *O’ to select
Open.

Clicking the mouse on the appropriate words of a menu command
has the same effect as executing them from the keyboard.

Many frequently used commands are assigned to the function keys
but they will be referred to by their complete menu path.

19
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Section 3.2. The Main Menu and the Status Line

FileMan consists of a series of commands which are arranged in pull

down menus. At the top of the screen a menu bar is displayed. To open a
menu from the menu bar you may either press Alt+C (where C is the
highlighted letter in the name) or you may press F10 to select the menu, scroll
to your choice, and press Enter. For example, typing Alt+F (hold down the
Alt key and press the letter 'F’) will open the File menu. You can also click the
mouse on the menu item you wish to open.

With a menu open on screen, there are several ways to select a
command from the menu. You can use the cursor keys to scroll to your choice
and press Enter, you can press the highlighted letter of your selection ifit has
one, or you can click the mouse on your choice.

You will notice some of the commands in the menus have a key or key
combination displayed to their right. These are shortcut keys. You may
execute a command which has a shortcut key simply by typing the appropriate
key combination without having to go through the menus.

Some commands are not usable at all times. A command name may

be displayed in gray in the menu. This indicates that the command is not

currently active.

For more information about a particular command, see the appropriate
section below. The manual is organized to correspond with the arrangement of

the commands in the menus.

At the bottom of the screen the status line is displayed. This displays
various keys and commands which may be used, and short hints to help you
along. It changes to show different data based on where you are in the

program.

20
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Section 3.3. How To Use Help

Pressing F1 at any time will bring up the Help window. If specific

help is available for the part of the program you are in it will be displayed. To
view more text than is visible in the window use the arrow keys to scroll the

window.

The highlighted words are cross references to other areas of the help

system. The Tab and Shift + Tab keys allow you to move the cursor from one

cross reference to another. Pressing the Enter key will select that particular help

topic.

To exit from the help system press Escape or click the mouse on the

window’s close icon. This will close the help window.

21
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Section 3.4. How To Use A Mouse

FileMan is based on a Multiple Document Interface (MDI). The MDI
allows you to open several windows and carry out multiple tasks simultaneously.
In this environment a mouse can be very useful. It provides a quick easy way
to rearrange overlapping windows, move from one window to another, and
perform a variety of other functions. For these reasons the use of a mouse is
highly recommended.

If a mouse driver is installed on your system, the software will
automatically work with the mouse. When using the mouse, all operations are
performed using the left mouse button. Double clicking the mouse (pressing the
left button twice rapidly) is similar to pressing the Enter key. You can do this
to close dialog boxes, select items from lists, and other similar operations.

There are several features of FileMan which apply only to users
equipped with a mouse. Each window has several icons on the frame. In the
upper left hand corner there is a small box. This is the Close icon. Clicking
the mouse on this spot will close the window or Dialog Box. In the upper right
hand corner there is a small arrow. This is the Zoom icon. Clicking the mouse
on this icon will enlarge the window to fill the desktop. Clicking the mouse on
it when the window is zoomed will reduce the window to original size. The
remainder of the top frame of the window is known as the window Title. If you
place the mouse on the Title Bar and depress the left mouse button, you can
drag the window to a new location. Release the mouse button when you have

positioned the window where you wantit.

22
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Section 3.5. The Dialog Box

A Dialog Box is a type of window used for data input. Dialog boxes
typically contain several different controls possibly including buttons, check
boxes, input lines, and list viewers. When a dialog box is active on screen all
inputis directed to it until it is closed. Therefore you must complete the task
for which the dialog box was opened before continuing. Some dialog boxes you
will use are System Info, and Print Setup. To move from one control to another

within a dialog box, you may use the Tab and Shift + Tab keys or the mouse.
The Tab key will move you from one control to the next in a predefined order.
The Shift+Tab key moves in the opposite direction. When a highlighted
character appearsin the label of a control you can press Alt+C (where C is the
highlighted character) to instantly move to that field. Clicking the mouse on a
control or its associated label will make that control active.

Any changes made in a dialog box will not take effect until the dialog
box is closed by pressing Enter or the Ok button. If you wish to abort the
operation, press Escape or the Cancel button and no changes will be made.

Section 3.6. Editing Data

Dialog boxes can contain a variety of different controls. The dialog
box below includes a set of radio buttons for time increment selection, check

boxes for storage calculation, , a text input box for a project title, and Ok and

Cancel buttons. These controls will be explained below.

Input Boxes

One of the most common editing controlsis the input box. These allow
you to enter and edit text or numeric data. Often the box will already contain
some information. If it does the contents will be highlighted. If you simply
begin typing in new data, the highlighted data will be deleted. If you wish to
edit the existing data you may use the Home, End, Insert, Delete, Backspace,

and Cursor keys. As soon as you press any one of these keys the highlight will

disappear from the existing contents and it will no longer be marked for
deletion.

Numeric input boxes differ from text input boxes in one respect. If the
data contains invalid characters or is out of range, a beep will sound and you

will not be able to close the dialog box.

23
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When editing text in an input box you are in either Insert or Overwrite
mode. Insert mode inserts new text in existing text without losing any
characters. Overwrite mode causes characters typed from the keyboard to

overwrite an equal number of characters already entered. The Insert key toggles

back and forth between these modes. It is easy to determine which mode you
are in based on the cursor shape. The Insert mode cursor looks like *’ while

the Overwrite cursor looks like "Jf.

List Boxes

Another commonly used data entry controlis the list box. This displays
a scrolling list of selections, one of which is highlighted. The up and down
arrows, and PageUp and PageDown keys move the cursor up or down by a line
or a page respectively. Ctrl+PageUp and Ctrl+PageDown will move the

cursor to the top and bottom of the list respectively. Examples of list boxes
include the file window, and the Devices list box displayed by the Draw Setup
command. Some list boxes allow you to select an item for further editing by
pressing Space. When in the file window, you will press Space to modify an
existing data line.

Buttons

Push buttons are used to perform some action. Typically you will see
Ok’ and ’Cancel’ buttons in a dialog box. Pressing the Ok button signals that
you have finished entering data. Pressing the Cancel button means you wish to
cancel the operation, exiting the dialog box, without changing any data. Often,
when several buttons are displayed, one of them will be a default button. It

will display in a different color from the other buttons. Pressing Enter

corresponds to pressing the default button.

24
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Radio Buttons

Radio buttons are another type of control you will see in this
application. Radio buttons allow you to select any one option from a series of
choices. They function like the buttons on a car radio, in that when you press

any button to selectit, all other buttons are unselected. You can use the cursor

keys to move fromselection to selection, selecting the one you want. Pressing
Space will select the current option. The File Type control in the File Open
dialog box is an example of a set of radio buttons. It is used to select the type
of file you wish to open.

Check Boxes

Check boxes are another type of button used. They are similar in

appearance to radio buttons, but each selection may be turned on or off,

independently ofthe other buttons. Again pressing Space will toggle the setting
of the current button. Check boxes appear in the Options Configuration dialog
box, where you may turn a variety of options on and off,

25
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Section 3.7. Logging In

The first step in using FileMan is to start the program from DOS. This
may be done by typing FILEMAN or FM at the DOS prompt or it may be

started from a batch file or menu program. For more information on this see
the Installation section.

A prompt appears asking for user identification. At this point you
should enter either your name, initials, or some other standardized code. This

name will be attached to any files created or modified by you. If you press
Escape the program will terminate.

If there is only one person who uses FileMan or if you do not wish to
attach user names to files you may avoid the Login screen by setting a DOS
environment variable. If the USER environment variable is defined the Login
screen will not be displayed. For example if Dave W. Stevens is the only
person who uses FileMan you can type:

SET USER=DWS

at the DOS prompt and whenever FileMan is started the user name will
automatically be set to DWS. This command could be added to the FM.BAT
file, preceding the line containing the FILEMAN command, or it could be
placed in your AUTOEXEC.BAT file.

If you have set the USER variable and wish to undefineit this is done

by typing the following DOS command:

SET USER=
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Section 3.8. Getting Started

Before you can perform any other functions you must have a data file

to work with. Until you opena file all you see on screenis the blank desktop,

the menu bar, and the status line. When FileManis first started, the Open File
dialog box opens automatically so you can immediately select a file.

Files are opened and created through the Open entry in the File Menu.
To select this command first press Alt+F in the Main menu to select the File
menu. Now you will see the various options in the File menu. Press *O’ to
select Open. When you do this the Open File dialog box will appear, prompting
you for a filename and type. Remember, you can exit any dialog box without
taking any action by pressing the escape key. The escape key is used to abort
an operation or exit a dialog box.

To create a file simply enter a filename. Legal filenames are from 1
to 8 characters long and must consist of alphabetic and numeric characters.
Certain punctuation symbols are also allowed. The rules are as for DOS with
one additional limitation: a filename extension will not be accepted because the
extensions are reserved for FileMan’s use.

FileMan uses the following file extensions to differentiate betweenthe
different file types:

.FCG Cogo Files

.FTP Topo Files

.FST Baseline (Stake) Files

.FPG Gradeline (PGL) Files

.FTM Template Files

.FCS Gradesheet Files

If you want to select a file type other than Cogo (the default) you

should type Alt+C where C is the highlighted characterinthe file type you wish
to select.

For example to create a Topo file named J9876 you could type Alt+T
(to select Topo file type), then type N (to select the File Name input box), then
type J9876 and press Enter. If you are using FileManfor the first time be sure
to select the Cogo file type as this is what you should become familiar with first.
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The Tab and Shift + Tab keys also allow you to move from one field to another
so it is not necessary that you enter the information in the order described here.

FileMan maintains a history list of the most recent files you have
worked with. To choose a file fromthe history list press the down arrow while
at the filename input box. If using a mouse click on the small arrow to the right
of the input box. A list of the files will be displayed and you may select a file

by positioning the cursor on it and pressing Enter. After retrieving a name from
the history list it can be edited. Press Escape to abort the history list operation.

If you are unsure of the filename you wish to open you can view the
available files by selecting the filename window, which shows all the filenames
in the current directory. If there are more files than will fit in the display
window it can be scrolled using the cursor keys or by clicking the mouse on the
scroll bars. From here you may select a file by using the arrow keys to

highlight the filename you wish to select, and pressing Enter.

Some users only want to use FileManto transfer data from their CAD

systems to Party Chief for stakeout purposes. If this applies to you, the
following steps are required.

1) From your CAD software export the data to an ASCII file. Note the

file name and directory where the ASCIIfile is placed.

2) Open a new file in FileMan using the File Open command.
3) Use the Transfer Define ASCII Format command to set FileMan’s

ASCII format to match that used by your CAD software. Try selecting
type 2 (#,Y,X,Z,T) with a comma as the delimiter if not sure. You
can also use the Transfer Test ASCII command to see the format of
the file generated by your CAD.

4) Import the data from the ASCII file generated in step 1 using the
Transfer Import ASCII command.

5) Use the Transfer Write48 command to send the points to the HP48.
6) You may now wish to save the points within FileMan so if you need

to transfer them again you do not have to transfer them from CAD.
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Section 3.9. The File Window

Each file opened is displayed in a file window. The file window
contains the file name on the top line, a heading section, and a scrolling list of

the data points. The following example shows a Cogo file which has been
generated using FileMan’s Topo Conversion feature.

 

File Edit Transfer Print Draw Options

Name North East Elevation Text
   

2d

TL17 642780.76610 845573.47358 765.03744 2 Break Line &:
TL18 642846.31124 845439.35464 759.01545 150 INV. 12 Pg:
TL19 642609.17015 845766.48046 768.77623 1 Fence Line =:
TL20 642629.14732 845720.32037 769.95510 2 Fence Line
TL21 642563.64876 845695.52315 774.61765 2 Fence Line
TL22 642545.81063 845742.30053 773.25661 2 Fence Line
TL23 642569.60373 845688.41699 777.11298 150 SAPLING
TL24 642578.21637 845691.07276 776.64788 150 SAPLING
TL25 642588.29883 845694 .06603 776.12584 150 SAPLING
TL26 642598.27959 845697 .36666 775.60852 150 SAPLING
TL27 642607 .86766 845700.97032 774.96060 150 SAPLING
TL28 642617.93659 845705.10333 774.25048 150 SAPLING
TL29 642479.71882 845716.95098 776.90452 1 Fence Line
TL30 642503.05649 845655.71262 786.08904 2 Fence Line
TL31 642481.94018 845653.01734 786.61849 2 Fence Line v

 

  
 

 

 

 

 

   
 

 

 

 

 
   
 

 

 

 

 

   F1 Help Alt+X Exit FileMan48 | User: EJP
 

Note the headings of Name, North, East, Elevation and Text which

appear at the top of the screen. The file is displayed below this, one point to
a line. The current point is displayed in a contrasting color. If you have just
selected a file the current point will be the first point. When opening a new file
there will be no points, only the headings will be displayed.

The scroll bar displayed on the right edge of the window shows your
current position within the file and also allows you to scroll through the file with
a mouse. The up and down arrows at the top and bottomof the scroll bar can

be clicked on with the mouse to scroll one line in either direction. You can also
click on the scroll bar either above or below the indicator to PageUp and
PageDown. Finally you can click and drag the indicator to move to another
position in the file.

The file window also includes two icons on the top frame. At the left

is the close icon- clicking the mouse on this will close the window. At the right
is the zoom icon- this enlarges the window to fill the full screen.
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Section 4. The File Menu

The File Menu contains commands that are associated with maintaining
your file system and manipulating file windows on the desktop. To open the
File menu type Alt+F or click your mouse on the File entry in the menu bar.

The menu is divided into several sections. The first section contains

the basic commands, Open, Save, and Close, and these are the ones you should

become familiar with first. Also at the bottom of the menu notice the Exit

command. This is used to leave FileMan. The shortcut key for the File Exit
command is Alt+X. This is also displayed on the status line most of the time.

Section 4.1. File Open

The File Open command allows you to access existing files and create
new files. To select this command first press Alt+F at the Main menu to select
the File menu. Now press 'O’ to select Open. When you do this the Open File
dialog box will appear, prompting you for a filename and type. Remember, you
can exit any dialog box without taking any action by pressing the escape key.
The escape key is used to abort an operation or exit a dialog box.

To open a file simply enter a filename. Legal filenames are from 1 to
8 characters long and must consist of alphabetic and numeric characters.
Certain punctuation symbols are also allowed. The rules are as for DOS with

one additional limitation: a filename extension will not be accepted because the
extensions are reserved for FileMan’s use.

If you want to select a file type other than Cogo (the default) you

should type Alt+C where C is the highlighted characterin the file type you wish
to select.

For example to create a Topo file named J9876 you could type Alt+T
(to select Topo file type), then type Alt+N (to select the File Name input box),

then type J9876 and press Enter. The Tab and Shift + Tab keys also allow you
to move from one field to another so it is not necessary that you enter the
information in the order described here.

30



FileMan48 Version 3.3

FileMan maintains a history list of the most recent files you have
worked with. To choose a file fromthe history list press the down arrow while
at the filename input box. If using a mouse click on the small arrow to the right
of the input box. A list ofthe files will be displayed and you may select a file
by positioning the cursor onit and pressing Enter. After retrieving a name from
the history list it can be edited. Press Escape to abortthe history list operation.

If you are unsure of the filename you wish to open you can view the

availablefiles by selecting the filename window, which shows all the filenames
in the current directory. If there are more files than will fit in the display
window it can be scrolled using the cursor keys or by clicking the mouse on the
scroll bars. From here you may select a file by using the arrow keys to
highlight the filename you wish to select, and pressing Enter.

Section 4.2. File Save

The File Save command writes the current file to disk. If the file has

been modified then the file’s date, time, and owner are updated to reflect the

new status.

Section 4.3. File Save As

The File Save As command allows you to write a file to disk giving it
a new name. This leaves the original file unchanged on disk. When you
execute the File Save As command a dialog box will open on screen. The

current filename is displayed in an input box where you can edit it. If you enter
a valid filename and press Enter a small window will appear on screen
indicating that the file is being saved.

If a file already exists with the new name you specify you will be asked
if you wish to overwrite it. If the new name you specify includes a subdirectory
which does not exist FileMan will not create the subdirectory and the file will
not be saved.
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Section 4.4. File Rename

The File Rename command allows you to give a file a new name or to
moveit to another directory on the same disk. The current path and name will
be displayed in an edit box and you may modify them as necessary. Pressing
Escape will abort the process. If a file exists with the new name the renaming
will not succeed.

You may movea file from one directory to another by renaming it but
you can not move a file from one drive to another. To move a file to another

disk you must use the File Save As command. If the new name you specify
includes a subdirectory which does not exist FileMan will not create the
subdirectory and the renaming will not succeed.

Section 4.5. File Delete

The File delete command allows you to delete the current file. The
name of the file will be displayed and you will be asked to confirm the deletion.
The deletion will not occur unless you respond Yes. If you do delete the file
the file window will be closed.

Section 4.6. File Information

The File Information command allows you to see the access information
maintained for each file. The file’s directory and name are displayed, as well
as the date of last modification and the name of the person who modified the
file. Also displayed is the total number of points in the file, the number of

groups, and a short summary of the point ranges of each group included in the
file. This point range information can be useful when transferring or printing
a range of points. Each File also has an optional Title where you can enter
descriptive information about the file. This information is included on any
printouts you make.
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Section 4.8. Changing Directories

Each time you execute the File Open command you will start in the
default directory. It is possible to browse through other directories or open a
file in another directory if you wish. If you wish to select another directory as
the default for the File Open command use the File Directory command. This
allows you to select a different directory or drive as the default.

A drive ordirectory may be selected by entering its name into the input

box. You can also use the graphical representation of your directories to
navigate throughout the directory tree. At the top of this tree is a line labelled
"Drives’. Clicking the mouse or pressing Enter on this line allows you to select
from the available drives. Selecting one of the directory names places you in
that directory.

Section 4.13. DOS Shell

Selecting DOS Shell will allow you to run DOS commands without
ending your FileMan session. The screen will clear and your standard DOS
prompt will be displayed.

When running in a DOS subshell under another program you do not
have use ofall the systems memory as you are sharing the memory with at least
one other program. Forthis reason some programs which require large amounts
of memory will not be able to execute. For example you will not be able to run

a second instance of FileMan in a DOS shell.

When you are ready to return to FileMan use the DOS command

EXIT’ to end the shell. Remember, until you exit from the DOS shell
returning to this program, the software is residing in your computer’s RAM.

If you have edited any data without saving, it will be lost if you do not
eventually return to the program and save it.
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Section 4.14. Exit FileMan

To leave FileMan use the File Exit command. The shortcut key

combination for this command is Alt+X. This is displayed on the Status Line.
If you attempt to leave FileMan when you have modified a file you will be
asked if you wish to save it first. If this occurs you may respond with either
Yes, No, or Cancel. If you answer Yes the file will be saved. If you answer
No you will quit without saving. If you select Cancel you will remain in
FileMan without saving.

34



FileMan48 Version 3.3

Section 5. The Edit Menu

To view the edit commands available select Edit from the Main Menu.
In the Edit Menu the various editing commands are displayed. The keys
displayed beside the commands are ’shortcut keys’ which allow you to access
the commands without going through the Edit Menu. In practice you will
probably never use the Edit Menu unless you are using a mouse as it is much
easier to use the shortcut keys.

The current point is displayed on screen in a contrasting color. If you
have just selected this file the current point will be the first point.

The keys displayed in the Edit Menu, along with the up arrow, the
down arrow, PageUp, and PageDown, are the keys used in the file window.
The left and right arrows are also used when working with a Topo file to show
either the measurements or the codes.

The up and down arrows are used to scroll through the file. They also

select the current point which is shown in a contrasting color. This point is the
one which is affected by the Delete and Modify commands. PageUp and
PageDown move through the file one screen at a time. Ctl+PageUp and

Ctl + PageDown also move to the top and bottom of the file respectively.

Section 5.1. Insert Points

The Edit Insert command is executed by pressing the Insert key. A
new point will be created and the Modify window will open to allow you to
enter data. You may now move through the fields displayed in the Modify
window entering data. The Tab and Shift + Tab keys and the Enter key move
the cursor from field to field. Pressing the Ok button will terminate editing of

that particular point. Pressing Escape will abort without creating the point. The
newly entered point will be added to the file if it has a valid point name. To
leave Insert mode press Escape. When you leave Insert mode the last point
entered becomes the current point. The cursor will move to that line and it will
be highlighted.

For more information on dialog boxes and the various editing controls
see Section 4, Using FileMan, especially the Dialog Boxes and Editing Data
sections.
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Section 5.2. Delete Point

The Delete command deletes the current point. It should be noted that
the point has only been deleted in memory however. No changes become

permanent until the file is saved to disk. Therefore if you should delete data
accidentallyit is possible to retrieve it by exiting from FileMan or closing the
file without saving. However this method will cause you to lose any other
changes which have just been made.

FileMan contains an option which causes it to ask you to verify the

deletion of a point. This option defaults to Confirm Deletion. If you need to
delete a large number of points or find this to be inconvenient, the feature can

be turned off from the Options Configure Menu.

Section 5.3. Modify Point

The Modify command allows you to edit the contents of an individual
point. To modify an existing point press Space or Enter. This will open a
dialog box displaying the contents of each field. The Tab and Shift +Tab keys,
or the mouse may be used to select a field. You may just type new data to
replace the existing contents of an input box, or use the cursor control keys to
edit the existing contents. The Delete key will entirely erase the field allowing
new information to be entered. See the Editing Data section on page 23 for
more information on input boxes and other editing controls. After modifying
a point the current point advances to the next point. For easy use of the
numeric keypad FileMan allows you to use the Plus key (on the keypad only)
as a Tab key for moving from field to field. See the Options Configuration
dialog box to enable this option.

Section 5.4. Finding Points

To move quickly to a certain position in a file use the Edit Find
command. This is selected from the Edit menu. You will now be prompted for
a point name. If the point is found that point becomes the current point, and is

highlighted on the screen.
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Section 5.5. Searching For Data

The Edit Search Data command allows you to search the current file for

a character string. For example, with a Cogofile you might wishto searchfor
a string such as 'IRON PIN’ which appears in the Text field, or a coordinate
value such as ’6543.210°. The first point in the file containing the character
string will become the current point. If you wish to continue searching fromthe
current point, see the Edit Search Again command.

Section 5.6. Search Again

The Edit Search Again command repeats the last search from the

current position. For example, if you performed the search for ’IRON PIN’
described in the last section, you could repeatedly use the Search Again
command to locate all points in the file containing the character string 'IRON
PIN’ in the text field. A message will be displayed when no more matching

points are found.

Section 5.7. Renumber Points

The Renumber command allows you to renumber a range of points.

You can also give a point range a new prefix.

When you execute the Renumber command you will be prompted to

input a point range, specified by a prefix, a beginning number, and an ending
number. You will also be able to select sequential or non sequential numbering.

This is only a factor if there are gaps in the point range you specify. If you
choose sequential numbering any gaps will be removed. If you choose non

sequential numbering each point number will be changed by the same increment.

After specifying the range to renumber, you will be prompted for the

new prefix to use, and the new beginning number. The Renumber command

can deal with overlapping source and destination ranges such as shifting a range
up or down by one. However,if the destination range contains other points
(which were not included in the source range) these will be overwritten.

Also,if you select sequential numbering to remove gaps trom a range, you must
specify a lower beginning number, or a different prefix to avoid conflicts. This

is because FileMan must start renumbering from the low end of the range when

sequential is selected.
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Section 6. Cogo Menu

The Cogo menu includes commands which are used to perform numeric
computation, suchas area computation and Topo reduction. These functions are
included only with Advanced FileMan.

Section 6.1. Compute Area

The Compute Area function allows you to compute areas from a series
of Cogopoints. Both lines and curves may be used. The points defining your
figure are entered in a list, separated by spaces. To compute curves, enter the
radius point preceded by a minus sign. For example, to compute the area ofthe
LOT1 example file given in the Party Chief manual you would enter:

1234-8561

You may close the figure (by specifying the starting point as the ending
point) as shown here, but it is not required. If you do not, FileMan48 will
automatically close it for you. As with Party Chief you can not start or end on
a radius point.

You can run around the figure either clockwise or counterclockwise.
If you would prefer to see interior angles, run counterclockwise. When you
press the compute button, the area and perimeter of the figure will be displayed.
If this looks correct, you can press the print button to get a complete printout
including coordinates, right hand angles, bearings, distances, and curve data for
any curves included.
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Section 6.2. Topo Reduction

FileMan includes software for converting raw topo data to XYZT
coordinates. When you select Topo Reduction from the Cogo menu you will be
prompted for a point range to convert.

Next you will be prompted for a Control Cogo File. You should enter

the name of a Cogo file which contains the coordinates for any control points
occupied, backsited, or used as benchmarks in the Topo file. The Topo file will
show these point names in the Info field and the corresponding points will be
found in the controlfile.

If you do not have a file containing these points it should be created,
the points entered, and the file saved, before running Convert.

Using these control points and the codes contained in the Topo file
coordinates will be generated for each point. These will be displayed on screen
as they are computed. If elevations exist in the control file for the occupied,
backsite, and benchmark points, a vertical error may be displayed.

Next you will be prompted for a destination Cogo file into which the
points will be inserted. This may be the samefile as the control file. Note that
the Cogo file can have the same name as the corresponding Topo file. If you

wish you may abort the process at this point without saving the points.

After entering a filename you will be asked what prefix you wish to
give the points and how to handle duplicate point names. The points will now
be read into the destination Cogo file and it will become the current file.
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Section 6.3. RPN Calculator

FileMan includes an RPN (Reverse Polish Notation) calculator which

is designed to function similarly to the Party Chief™ software on the HP48™.
The calculator includes the basic math functions (+ - * /), RPN functions such

as Swap, Drop, Pick, Clear, Neg, and Fix, and also includes the surveying
functions Traverse, Inverse, SideShot, StakeoutTie, Offset/Run, StorePoint,

and RecallPoint. The DMS +, DMS-, DMS*, and DMS/ functions are also

available by holding down the shift key when pressing +, -, *, or /.

 

 File Edit Transfer Print Draw Options
——————————————————— 0: \FILEMAN\DATA\ 0614 .FCGre|

Name North East Elevation Text |

FC1 652658.58170 840818.96070 0.00000
FC2 652629.36580 840825.77470 0.=[m]= RPN Calculator
FC3 652649.32770 840790.42370
FC4 652641.25540 840731.01720
FC5 652650.50940 840759.55420
FC6 652611.77010 840736.55050
FC7 652643.17540 840985.15490
FC8 652676.96010 840972.72140
FCI 652636.00830 840966.48680

FC10 652669.43340 840953.11670
FC11 652586.05980 840794.72900
FC12 652554 .36350 840625.82770
FC13 652589.74590 840619.18770
FC14 653741.62400 840436.21160
FC15 653774.40480 840395.09530
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The Calculator can be selected from the Options menu or can be
popped up using the shortcut key Ctl+F1. A window will open displaying a
calculator with a multiline screen and a series of buttons. Performing basic
math functions on the calculator works exactly as on the HP48. For example,
to add two numbers, type in the first number, press Enter, type in the second
number, and press the Plus key. Pressing Enter directly before the math
operation is optional. This coincides with the way the HP48 calculator operates.

Cogo Programs

The Cogo programs are designed to coincide as closely as possible with
those on the HP48. They are comparable to the programs when Party Chiefis
operated in Advanced Mode. Brief descriptions are provided here, and
differences are noted, but for additional instruction on the use of these routines
see the Party Chief manual.
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The ability to store and recall points is provided. The calculator will
interface with the Cogo file which is currently selected on the desktop when
working with point numbers. If you use prefixes within your files the Prefix

routine allows you to set five active prefixes in the same way the Files program

operated within Party Chief. The prefixes are numbered 0 through 4 and points
with that prefix can be accessed by typing PointNumber.Prefix. For example,
if you have defined prefix 0 as TR’, and prefix 1 as OL, then entering the
following keystrokes would Inverse from TR7 to OL23:

7 Enter

23.1 Inverse

Note that you do not have to enter .0 to access file 0: this is the default. If you
do not use prefixes then all your points can be accessed just by point

number, as long as prefix 0 is left blank.

Store Point

The StorePoint function allows you to generate points in a Cogo file
fromthe calculator. With the north and east coordinates on the stack, just enter

a point number and press the Store key.

North 5632.1127

East 10348.8944

24.1 Store

Assuming that Prefix 1 is still OL as described above, this will store
the north and east coordinates as OL24.

Elevations may also be stored. Place the north, east, and elevation on

the stack in this order. Now enter the point number as a negative number and
press the Store key. This will store the elevation in addition to north and east.

Recall Point

The RecallPoint function allows you to work with coordinates stored in

a data file. To recall a point, just enter the point number (with the optional
prefix number) and press the Recall key. To recall the coordinate stored in the

previous example just enter 24.1 and press Recall to retrieve the north and east
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coordinates of OL24 to the stack. To recall the elevation also, make the point
number negative before pressing Recall.

Inverse

The Inverse function computes the bearing and distance between two
points. The points may each be either a point froma file or coordinates entered

on the stack.

To Inverse between two points stored in a file just enter the two point
numbers on the stack and press Inverse. If you wish to use coordinates, either
point number may be replaced by a north and east coordinate pair. The
following example illustrates Inversing from a point in a file to coordinates.

7 Enter (Point number)

6392.6446 Enter (North)

10382.7133 Inverse (East)

The program determines what is a coordinate and what is a point
number based on the setting of the Maximum Point Number variable. The
default for the Maximum Point Number is 999. This means that any number
less than 1000 is interpreted as a point number, and a number greater than or
equal to 1000 is used as a coordinate. The Maximum Point Number can be set
to 0, 99, 999, 9999, 99999, or 999999. For example, if you wish to use

coordinates of less than 1000 the you should select either 0 or 99. Selecting 0

means all numbers will be interpreted as coordinates.

Traverse

The Traverse function allows you to traverse from a point or
coordinates, using a bearing, or turning an angle from the backsite. It also
works similarly to the Traverse function in Party Chief. The following example
illustrates Traversing from a point using a bearing and distance.

8 Enter (Point number)

1043.5930 Enter (N 43°59°30" E)

143.25 Traverse (Distance)
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Coordinates for the new point will be returned to the stack and you may
then enter just an angle and distance or bearing and distance to continue from
the current point.

After Inversing or Traversing to establish a backsite, you can use a

right hand angle from the backsite in place of the bearing. To use a left hand
angle press the Negative key to make the angle negative.

SideShot

After establishing an instrument location and backsite, the SideShot
program can be used to generate coordinates from angle and distance data.
Input to the Sideshot routine is Angle and Distance as in Party Chief. Use
negative values for left hand angles.

1 Enter (Point number)

2 Inverse (Point Number)

49.5945 Enter (Angle of 49°59°45")

192.25 SideShot (Distance)

After performing the steps above, north and east coordinates for the
point are generated. Note that multiple sideshots may be computed from a

single instrument location. Just repeat the last two steps above.

StakeoutTie

After establishing an instrument location and backsite, the StakeoutTie
program can be used to generate bearing, distance, and right hand angle data

from coordinates or a point number. Input to the Sideshot routine can be either
a north and east coordinate or a point number as in Party Chief.

1 Enter (Point number)

2 Inverse (Point Number)

3 StakeoutTie (Point number)

After performing the steps above, the bearing from the occupied point

to the tied point is displayed along with the distance and the right hand angle
from the established backsite.
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Baseline

The Baseline program cooresponds to the Point-Point program in Party
Chief. This program functions just like Inverse except that it does not set the
occupied point. It may be used when you wish to check ties between points but
do not want to affect the current setup. Input to the program is 2 points where
the points may be represented by point numbers or coordinates.

An additional function of the program is that it establishes the baseline
used by the OffsetRun program. It also can be used to establish a second
baseline (in addition to the one established by Inverse) for use in Line/Line
intersections.

Offset/Run

The OffsetRun program computes the offset and run of a point relative
to a baseline. The baseline must already be established by using the Baseline
program. Input to the Offset/Run program is a single point or coordinates.

1 Enter (Point number)

2 Baseline (Point number)

5 Offset/Run (Point number)

The offset and run to the point are now displayed. Note that a right
hand offset is positive, left is negative. Also the run is from the second point
(in this example point 2).

Intersections

Line-Line, Line-Distance, and Distance-Distance intersections may also

be computed. This program is accessed by the XQ8 button and functions
similarly to the intersection programs in Party Chief.
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Section 7. Transfer Menu

The Transfer Menu contains all the commands associated with moving

data in and out of FileMan.

FileMan is designed to allow you to communicate with an HP48
computer running Party Chief and with PC based surveying programs.
Communication with Party Chief is accomplished using the Kermit file transfer
protocol built into the HP48. Communications with other PC based software is
in the form of ASCII text files. Fileman allows you to read and write ASCII
text files with a standard structure which most design programs can also read
and write.

Section 7.1. Kermit

Communications with the HP48 are handled using the Kermit file
transfer protocol. These file transfers should take place without any user
intervention. However if you have trouble transferring files the following
information will help you solve the problem.

When FileManstarts a Kermit transfer, a window will open displaying
status information. The current port and baud rate settings are displayed along
with the number of packets and bytes transferred, and the number of errors
which have occurred. A status line also displays what is currently happening
within the protocol. Should it become apparent that the transfer is not going to
work, or you do not wish to continue you can press Escape to abort the transfer.
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There are several reasons why the Kermit transfer might fail. These
may be divided into the following groups.

FileMan is unable to create transfer files.

There is not enough disk space available.
There are too few file handles available.

Transfer terminates immediately with "No UART at this address”

message.
You have not selected the correct port.

Kermit continues to retry but is unable to connect.
The HP48 is not connected to the correct port.
The correct port was not specified in Transfer Setup.
The baud rate is not the same on both devices.
The HP48 is not ready to transfer files.
The cable is not securely connected to the HP48.

Transfer begins but is aborted in the middle.
The HP48’s batteries are running low.

When FileMan communicates through a serial port it works directly
with your computer’s hardware, bypassing DOS and your system BIOS ( Basic
Input Output System ). This is necessary to achieve reliable file transfers at
high baud rates. Some computers may contain nonstandard serial port

configurations at the hardware level which are hidden from the user by a BIOS
which makes the appropriate adjustments. For example some computers we

have worked with actually have COM2: and COM4: serial ports installed rather
than the usual COM 1: and COM2:. However when accessed through DOS and

BIOS services they appear to the user as COM1: and COM2:. It is important
that when you specify a port to FileMan you specify the true port address. The
following tables show the standards for serial ports. Some serial port cards
allow the user to change the base address and interrupt number to a nonstandard
setting. Your serial port should conform to one of the following:
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PC Compatibles

 Port Name Base Address Interrupt

COM1 $03F8 4

COM?2 $02F8 3

COM3 $03E8 4

COM4 $02E8 3

PS/2 Standard

 Port Name Base Address Interrupt

COM1 $03F8 4

COM2 $02F8 3

COM3 $3220 3

COM4 $3228 3

The PORTID.EXE utility provided on the FileMan distribution disks
will list the serial portsinstalled in your computer and display information about
their setup.
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When Kermit terminates FileMan will display an error message

explaining the problem if one occurs and it is able to determine it. However
some of these problems can not be recognized by software. If you encounter

trouble the following sequence of steps should help.

First check the physical connections. Ensure that all connections are
secure and determine that they are to the proper ports.

Now enter the Transfer Port Setup dialog box and set the port and baud

rate to the proper values.

Verify that the communication parameters are set to the proper values
on the HP48 in the Read/Write 1/0 Parameters menu.

Proceed through the appropriate steps to initiate a file transfer with
both Party Chief and FileMan.

Remember that one end of the link must Transmit while the other

Receives.
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Section 7.2. Reading From HP48

The Transfer Read 48 command initiates the process of reading from
the HP48.

A status window will open on screen and the Kermit transfer will take
place. At this point it should not be necessary for you to do anything. The
Kermit transfer should proceed on its own, displaying the number of bytes and
packets transferred.

Communication between FileMan and Party Chief is handled by a high
level protocol which includes error detection and correction. Briefly, a file is
transferred as a series of blocks, where each block is transferred as a series of

packets, and each packet consists of a series of bytes.

When the transaction is complete the transfer window will close. Next
you will be asked what action you would like the program to take if it
encounters duplicate point names. It should be noted that if duplicate points
appear which have the same name and data the new points are disposed of
quietly. It is only when the data differs that you must decide which of the two
to keep. The Cogo Text Mode variable in the Options Configuration dialog box
determines whether differences in the Text field are recognized. See the
Configuration section for more information.

When reading data into a file you may select one of the following
methods of dealing with duplicate point names:

Overwrite Old point informationis automatically overwritten by
the new data received.

Prompt You will be asked at each conflict whether you wish
to Overwrite, Rename, or Dispose. This is the
option to choose if you need to rename the points.

Dispose This choice simply disposes of points which arrive
with duplicate names.

The points will now be displayed on the screen as they are received
(unless the Echo Points optionis disabled). If you selected the Prompt option
and duplicates appear the existing point will be displayed directly below the
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duplicate just received. You will now be offered a choice of Overwriting,
Renaming, or Disposing. Overwriting will cause the new point to overwrite the
old point. Renaming allows you to rename the new point. Disposing of the
new point preserves the old point already in the file. Pressing Escape or the
Cancel button will abort without processing any remaining points.

The primary cause of failed transfers is low batteries in the HP48.
Transferring data through the serial port requires more power than normal
operation of the HP48. If you are having trouble transferring you should
try replacing the batteries even if the HP48 has not reported a low battery
state. If the transfer aborts midway through, this also indicates low
batteries.
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Section 7.3. Writing To HP48

Use the Transfer Write 48 command to write a file to the HP48.
Before writing it is necessary that the proper settings have been made in the Port
Setup dialog box. On entering the Write command you will be asked for the
prefix of the points you wish to write along with the beginning point number,

the ending point number, and whether you wish to performa sequential transfer.

Party Chief’s data files consist of sequentially numbered points where
all points have the same prefix. Generally you should answer yes to the prompt

asking if you wish to fill in gaps in the point range. With file types other than
Cogo you do not have a choice. Nonsequential Cogo files are an exception to
this but they will be covered separately.

With file types other than Nonsequential Cogo the following limitations
apply to what points may be written to a single file:

All points must have the same prefix. This prevents the conflict of
having two points with the same number.

A continuous range of points must be written. This range can be of
any length from 1 up to the number of points you can fit in the HP48.
Therefore if any of the points are not found in Fileman’s files, the
points are written as containing zeros to fill the gap.

After entering this information a window will open and the status ofthe
Kermit transfer will be displayed. As with reading files it should not be
necessary for you to do anything. You can observe the process and if there
seems to be trouble you may abort by pressing Escape. The Kermit protocol

will continue trying to establish contact 15 times. If contact has not been made
by the third try or so it is unlikely that it will succeed so you should check your
cable connection to the HP48 and if this fails abort with Escape, go to the Port
Setup dialog box, verify the settings there, verify the physical connection, and
try again.

When the communications finish a message will be displayed indicating
the status of the transfer, and then the window will close.
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When writing Cogo data to the HP48 you have the option of writing
Sequential or Nonsequential files. The sequential file is the one discussed
above. Nonsequential files are a different type of Cogo file which may contain
a scattered range of points. When you write a Nonsequential file zero points are
not inserted to fill in gaps in the point range. However, in this type of file the
point name associated with each point must also be stored in the HP-48
consuming more memory per point. Another disadvantage of Nonsequential
files is that a point must be accessed by searching for its name rather than
performing an index calculation into the file. For this reason operations may
take longer with nonsequential files. In general it is much better to use a
sequential file unless you need such a wide range of point numbers within a
single file that its size would exceed the available memory of the machine.

The primary cause of failed transfers is low batteries in the HP48.
Transferring data through the serial port requires more power than normal
operation of the HP48. If you are having trouble transferring you should
try replacing the batteries even if the HP48 has not reported a low battery
state. If the transfer aborts midway through, this also indicates low

batteries.
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Section 7.4. Port Setup

Before reading or writing files certain parameters must be set. Thisis
done with the Transfer Port Setup command. Here you can set the

communications port you wish to use, and the baud rate. There are two sets of
radio buttons in this dialog box. The Tab and Shift+Tab keys allow you to
move among the options. The arrow keys are used to change a control’s setting.

For more information on how to operate these controls see the Dialog Box and
Editing Data sections of this manual.

The port should be set to whichever serial port your HP48 will be
connected to. This will typically be either COM1 or COM2. If you have
trouble, try both of these settings. If you get a "UART framing error" message

you have probably selected a port with a mouse attached. For more information
see the earlier section on Kermit.

Typically the baud rate is set to 9600 baud. This is the fastest rate at
which the HP48 can transfer data. If you experience a high number of
transmission errors (displayed in the transfer window) you may wish to try
lowering the baud rate (we have never seen this occur however). The important

thing to remember is that FileMan and Party Chief must both be set to transfer
at the same baud rate.

When all parameters are set to the proper values pressing Enter or the

Ok button saves your selections. Pressing Escape closes the dialog box without
changing the previous values.

The HP48 allows you to set the parity. All communications with
FileMan are done with no parity.
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Section 7.5. Communications Using ASCII Files

FileMan gives you the ability to read and write ASCII text files in a
format to suit most surveying software. Currently only Cogo files may be
imported, and Cogo and Topo files may be exported, as there are few

applications capable of working with the other file types.

Topo files may be exported in a format which emulates the Geo126™
data collector.

The format of Cogo files is defined by selecting the Define File Format
entry in the Transfer Menu. The ASCII files may contain any ofthe following:

Name, North, East, Elevation, Text

There are two general formats supported; Delimited and Fixed width
fields. There is a selector which allows you to choose between several different
configurations. Note that some configurations have the north (Y) and east
(X) fields switched. The Intro field also allows you to transfer to systems

which expect command words at the beginning of each line.

If your software supports comma delimited format (one of the most
common), and you wish to transfer all fields, select one ofthe first two options

(depending on whether your CAD software transfers in XY or YX order), and
enter a comma in the delimiter input box. You can ignore the remaining

options.

Note: Most CAD systems import and export in a comma delimited format by
default. Try setting Format to type 1 (#,Y,X,Z,T) first. In the
delimiter field enter a comma (,).
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Delimited Format

A delimited file uses a special character (a delimiter) to separate the
different fields. An example using a comma as the delimiter is shown below.

TP23,9876.54321,1234.56789,765.43210, IRON PIN FOUND

TP24,9753.24680,1243.65432,753.12345,MONUMENT FOUND

With delimited formats the field widths function in an on/off manner

only. Setting a field width to a non zero value includes the field, setting it to 0
excludes the field.

If your software reads points in a string format where the fields are
defined by a delimiter rather than fixed positions in the line then you should
select delimited mode, and enter the proper delimiter. In this case the field
widths need only be set to either zero to omit the field or a nonzero value to
include the field. Example 1 shows how to set FileManto read a delimited file.

It should be noted that when a delimited format is used a unique
delimiter which does not appear in any of the data fields is needed. If you are

using a character such as a comma or a colon you must ensure that it does not

appear in the Text field.

Fixed Width Field Format

With fixed width fields a delimiter is not used. Instead each field is
specified to appear at a particular range of character positions. In the following
example, the same point is displayed with field widths of Name =6, North=12,
East=12, Elevation=10, and Text=24.

TP23 9876.54321 1234.56789 765.43210 IRON PIN FOUND

TP24 9753.24680 1243.65432 753.12345 MONUMENT FOUND

You must specify the width (in characters) each ofthese fields should
be. Specifying a width of 0 will cause the field to be omitted.

To export points in a fixed field width format you should select the

fixed field option. When working with fixed fields a delimiter is not used.
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Example 1

56

You wish to interchange ASCII files with a CAD program which
expects only a name, north, and east coordinate, separated by commas.

Select: Other Delimited

Field Width

Enter: Name:

North:

East:

Elevation:

Note:

Delimiter: ’

( you do not enter the quotes )

2
,
O
O

e
m

=
m
=

Note that the field widths for Name, North, and East could be set to

any non zero value. The delimiter is not included in places where a

field is omitted so this format would read/write lines such as

’5412.1234,6231.9756’
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Example 2

Program expects to find a point name in positions 1-5, a north
coordinate in positions 7-18, an east coordinate in positions 20-31, an
elevation in positions 33-44, and a note in positions 46-63.
Since FileManright justifiesits fields in fixed field mode you must size
your columns to position the fields properly. The sum of a fields width
plusall the preceding field widths should be equal to the ending column
number.

Select: #YXZT Fixed Fields

Field Width

Enter: Name: 5

North: 13

East: 13

Elevation: 13

Note: 19

Delimiter: N/A

This will read/write lines of the form

’CL123 987654.0000 456543.2500 1203.0156 Highway CL’

To determine what position a field will begin in add the lengths of the
preceding fields, and add 1.

Most programs will be similar to one of these examples. You must
first determine which fields the program expects, and then place them in the
proper place. If field widths are greater than the information to be placed in
them, the information is right justified. Therefore a piece of information can
be moved side to side by adjusting the various field widths.

The most efficient format for FileMan to use is with fixed fields. This
avoids the overhead of scanning a line oftext for the delimiters. If your other
applications give you a choice offixed fields or delimited text you may wish to
use the fixed field format for increased performance.
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Section 7.6. Test ASCII Format

The Transfer Test ASCII Format command is used to set the ASCIIfile
format properly for importing Cogo data. It is useful when you have received
a file from outside your company and are unsure of the format. Several lines
of the file you wish to import are displayed, along with a
"character ruler’ which allows you to count characters, and a display of the

current ASCII format. This enables you to quickly see if you are properly set
up to import the file. To make changes use the Transfer Define Format

command.

 

File Edit Transfer Print Draw Options
 

 

[@)=——=——————=D:\FILEMAN\DATA\107 .FCG
Tr Name North East Elevation
—_—————— \/jew ASCII File Format
FC1 652658.58170 840818. 20s 0.00000
FC2 652629. 36580 840825.77470 0.00000

12345578901239867 390 12345678901 2342678901234567890 1234567890123456789012345678
1 2 3 4 5 6

[TITTTINNNNNNNNNNNNNNNNNEEEEEEEEEEREEEEEEZZ2227222222222ZZZ2ZTTITTITTITITITITTITINT

kdl

TL27 642607.86766 845700.97032 774.96060 150 SAPLING
TL28 642617.93659 845705.10333 774.25048 150 SAPLING
TL29 642479.71882 845716.95098 776.90452 1 Fence Line
TL30 642503.05649 845655.71262 786.08904 2 Fence Line

642481.94018 845653.01734 786.61849 2 Fence Line

  
      
  
     

 

   

        F1 Help Alt+X Exit FileMan48 User: EJP
 

In this example, the formatis properly set to import this file. Notice
how the fields of the file line up with the I, N, E, Z, and T characters which are

showing the current ASCII format. These characters represent the Identifier
(name), North, East, Z Value (elevation), and Text fields respectively. This

example illustrates a fixed field format with settings of 7 characters for Name,
17 characters each for North, East, and Elevation, and 24 characters for Text.
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Section 7.7. Import ASCII File

The Import ASCII File command works similarly to Read file. You
first specify the name of the file to be read. The same considerations apply for

handling duplicate point names. For information on duplicate points see Read
File in this section.

Section 7.8. Export ASCII File

The Export ASCII File command works much like Write File but with

Cogo files you also have the option of exporting the entire file rather than just
a range of points.

If the file you select to export to already exists you will be given the
options of overwriting the existing data, appending points to the end of the file,
or aborting the operation. The append operation is useful if you wish to export
ranges of points rather than the entire file. For example you might first export
the range of points from 1-10 selecting Overwrite if the file already exists. Now
you could append points 25-30, and continue this process to build an ASCIIfile
contains only some of the points in the main file.
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Section 7.9. Export DXF File

The Export DXF command allows you to export a Cogo file in DXF
format. Note that this command is disabled for file types other than Cogo.

When you execute the Export DXF command you will be prompted for

a filename to export. By default this file will be created in the current directory
but you can enter a full or relative pathname to place the file in any directory
you choose. If no extension is specified, a default of *.DXF’ will be assigned.

For the Export DXF command to work properly you must specify the
correct BGI Directory in the Draw Setup dialog box. This is because the DXF

headeris stored in this directory.

The DXF file created will by default contain layers POINTS,
SYMBOLS, TOPO, and COGO. These layer names may be changed or the

information in them omitted. Cogo points appear in layer POINTS. The point
names and text may optionally be included as point attributes. The SYMBOLS
layer contains symbol block references for coded symbols recorded in Topo
collection. The TOPO layer contains any linework collected in the field into a
Topofile and processed by FileMan. The COGO layer contains any additional
linework which has been connected manually in FileMan. This feature is not
fully implemented at this time. The points may be exported using three

dimensional coordinates.
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Section 8. The Print Menu

The Print Menu allows you to print either an entire file or a range of
points as discussed in writing a file to the HP48. The Print functions are
accessed from the Main Menu by selecting the Print option. This brings up the
Print Menu whichgives you the options of printing a file, a summary, or a point
range, or setting up the printer.

Before doing anything else you must set up your printer. FileMan can
use the DOS print spooler to allow you to continue working, or even exit
FileMan, while a file is printing. It is recommended that you use the DOS print

spoolerif you are not using network printers. If you are using network printers,
they generally include this function and may be written to directly.

If PRINT is not on your system and you wish to use print spooling it
will be necessary for you to install it. The best way to install the DOS print
spooleris from your AUTOEXEC.BATfile. Doing this avoids the possibility
of fragmenting your systems memory. FileMan’s installation program can do
this for you. To install the print spooler from your AUTOEXEC.BAT file you
would use a text editor to add a line similar to this:

C:\DOS\PRINT /D:LPT1

The default for this is C:\DOS\PRINT but it may be changed as
necessary. Some versions of DOS include the file PRINT.EXE while others
include PRINT.COM. One of these should be in your DOS directory. You
must also select the port to which your printer is attached. This can be either
LPTI1, LPT2, or LPT3, ( the three parallel ports ) or COM1, COM2, COM3,

or COM4 ( thefirst four serial ports ). Typically a printeris attached to LPT1
and this is the default.

You may also wish to use a memory management utility (such as the
LOADHIGH program included with DOS 5 and up) to load this program into
high memory. For more information on the PRINT program and modifying
your AUTOEXEC.BAT file see your DOS manual.
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Section 8.1. Print Setup

The Print Setup command opens a dialog box so you can specify the

type of printer you are using, the character pitch, and the margin sizes for

printed output. As part of the expanded network support, Print Setup now

allowsa variety of printers to be defined so you can switch among them quickly.
The Defined Printers listbox contains a list of all printer definitions created.
Initially this will contain one entry, "Default". With the listbox selected press
Space to modify the parameters of the Default definition. You can change the
description to something more meaningful to you, for example "Laserl" or
"Bob’s Dot Matrix" if you will print to a variety of printers on a network.

Next select the Device to which printing should be directed. To remain
compatible with previous software versions, and on most standalone computers
select DOS Spooler. This will direct output to the DOS print spooler so you
may continue to work while the printer is running. If you do not wish to use
the print spooler, or are connected to a network, you may wish to direct output
directly to a printer port (LPT1, LPT2, or LPT3). Use this on a network if the
network "captures" data sent to the printer ports and redirects it. Depending on

the settings of your printer and/or network you may or may not need to check
the Form Feed option. Turn it on at first, then turn it off if you are getting a
blank page after each job. The Form Feed option affects only the direct to port
modes. The DOS Print Spooler always form feeds at the end of each job.

The Executable option allows you to use a network print utility such as
Novell’s NPRINT.EXE to print a file. This optionis the hardest to set up but
may allow you to perform additional functions which you can not do using the
other methods. If you were installing the software on a Novell network and
wished to use this option you could enter a command such as

F:\PUBLIC\NPRINT.EXE [FileName] /Q=Laserl /NB /FF

First you specify the name of the print utility to be used. Specify the full
pathname and extension evenif the utility is in your DOS path. The remaining
parameters will change depending on the print utility being used but you should
enter [FileName] where the filename to be printed should be inserted, and any
other parameters required. In this example the /Q parameter directs the print
job to the Laser] print queue, the /NB parameter tells NPRINT not to print a

banner page, and the /FF parameter tells NPRINT to formfeed at the end of the

job.
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Next select the type of printer. Almost all printers manufactured today

are compatible with one of the three choices offered. These include IBM
compatible, Epson compatible, and HP LaserJet compatible. FileMan uses only
very basic printer commands such as setting margins and printing bold type.
Therefore full compatibility is not required. If you can not use one of these
three printers, or if you wish to configure your printer manually (such as
changing fonts or pitch) you can select Other which instructs FileMan to send
only ASCII text characters to the printer omitting all formatting and control
characters. After setting the printer type press the Ok button.

The default character pitch can also be set. This allows you to adjust
the number of characters per inch (CPI). You can choose between 10, 12, and

17 characters per inch with most printers. You can also specify a left margin
width measured in characters. This is useful if you wish to leave room for
binding or punching printouts. 17 CPI mode should be used with Topo, PGL,
and Stake file types unless you have a wide carriage printer as these file types
require more than 80 columns to print.

A related option is the Condense Wide Printouts variable in the Options
Configuration dialog box. If this option is selected, Topo, Stake, and PGL
printouts automatically use a 17 CPI font regardless of the pitch selected.
Another option you may wish to use is Break Pages which is also found in the
Options Configuration dialog box. When Break Pages is on, FileMan skips over
page breaks and prints a header on every page. If using a laser printer you will
most likely want this option ON. If using continuous tractor feed paper, you
may wish to turn page breaks off to save paper and time.

After entering all the information press the Default button to select the
highlighted printer as the current printer. All printouts will now be directed to
this printer until you select a new one by highlighting a different printer in the

Defined Printers list. Pressing the Default button will select the highlighted
printer for all future printing, or you can highlight a different printer and press
Ok. If you press Ok the highlighted printer will be used until you exit FileMan,
at which time it will return to the default.

If the printer is not set up properly then the other entries in the Print
Menu will not function.
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Section 8.2. Print Options

When printing you can choose to print a File, Summary, or Point
Range. The summary option will print a list of all prefixes and point ranges
included in the file, and the total number of points. If you select the Points
option you will be prompted for a prefix, beginning number, an ending number,
and whether to print sequentially. The default is nonsequential and this will
print only points appearing in the file.

You will now be asked to verify that the printer is online and ready.
Press Y’ to print or ’N’ or the escape key to abort the process.

The page heading at the top of each file is intended to fully define the
location of the data. The drive letter, complete pathname, filename, and file

type are all included. The disk’s volume label is also included. If you have
several PC’s in your office you may wish to give the hard disks appropriate
volume labels so you can track your data. If you store your permanent files on

floppy disks you might wish to give each floppy disk a volume label showing
the job or client’s name associated with the data stored on the disk. If you do
this you will always be able to positively identify the location of your data from
a printout.

When printing Gradesheet files by Range you must specify a setup
block as the beginning of the range. If you do not, no blocks will be printed
until a setup block is encountered.

Whenprinting Gradesheetfiles you are also given the option of printing
a full report. The full reportis intended for use by your office and containsall
the data associated with each setup and stake. The instant report contains only
that data which is customarily given to contractors and inspectors.
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Section 9. The Draw Menu

FileMan allows you to plot Cogo and Template files. They may be

viewed on screen, and printed on a variety of printers and plotters. Before
plotting you should set up the plot parameters using the Draw Setup command.

Section 9.1. Drawing Setup

The Drawing Setup dialog box allows you to set certain parameters
related to plotting. All plotting is done using a series of graphics drivers.
These are separate files which you received with FileMan. All the graphics
drivers have a file extension of .BGI. To be able to plot, FileMan must be able
to find these drivers. Typically, they will be installed in the \FILEMAN\BGI
directory, however the Setup dialog box allows you to specify the directory
where they can be found. This is done to allow multiple programs to share the
drivers without having duplicate files on your hard drive. Until you have
specified the correct BGI directory, the plot device list box will not display any
choices. If you are only interested in plotting on screen then the BGI directory
is the only option which you need to set.

After specifying the correct BGI directory, you can select a plot device.
You will notice that this list does not include any entries for the computer
screen. This is because the screen is always selected as an active device.

The Plot Setup dialog box also includes controls for selecting plot
quality and size. These will function somewhat differently depending on the plot
device selected. For example, some devices offer draft and letter quality modes
while others do not.

There are basically three different classes of plot devices other than the

screen. They are printers, plotters, and graphics file formats. All the single
color printers and the DeskJet offer 9 modes, a combination of 3 plot qualities
and 3 plot sizes. With dot matrix printers Medium quality usually gives the best
combination of both quality and print speed. Landscape mode is also generally
used. With the PaintJet the quality control selects 2, 8, or 16 color mode. With
Postscript printers the quality control selects mono, grayscale, or 16 color mode.

Most of the plotters offer 2 plot qualities (Medium or High will give the same
result) and up to 5 plot sizes (A-E). All the graphics file formats operate in one

mode only, with the exception of TIFF, where the quality control determines
resolution.
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There is also a control allowing you to specify which port your plot

device is connected to. If using a printer it will most likely be LPT1. Most
plotters are serial devices and will probably be attached to COM1 or COM2.
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Section 9.2. Draw File

A Cogo file can be plotted using the Plot File command. Executing
this command displays the Draw dialog box. You can turn on and off linework,

point names, symbols, the plot border (hardcopy only) and grid. You can also
specify the scale, in feet per inch, at which you want to plot. This scale applies

to hardcopy output only, not the screen display. Maximum and minimum
coordinate values are also displayed but typically you will not need to change
these. The default screen window will include the entire file.

Some of the options such as Linework are set either on or off. Other options

such as symbols may be set on, off, or ZOOMED. A ’?’ in the check box

indicates that ZOOMEDis selected. This means that the option will be turned
on depending on the scale selected. This prevents symbols or text from filling
the screen when viewed at a small scale.
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Press Enter or the Ok button to plot the file on screen. North is always

up as indicated by the north arrow on the side of the display. A bar scale is
displayed in the corner of the display indicating the scale of the plot.
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This plot is from the EXAMPLEI1 Cogofile included with FileMan.
It is collected Topo which has been converted by FileMan, and shows the use
of line and symbol codes.

The current point is highlighted and its name, coordinates, and text
fields appear at the bottom ofthe display. You can use the up and down arrow
keys to change the current point just as in Edit mode. Clicking the mouse on

a point will also select it as the current point. The Search Radius parameter
specifies the radius which you must click the mouse within. You also have the
ability to zoom in and out. The current point is the target towards which you
will zoom. The right arrow zooms in by a factor of 1.5 (50% enlargement)
while the left arrow zooms back out. While zooming either direction, holding
down the Shift key changes the scale by only about 5% while holding down the
Control key changes the scale by about 500%.

 10pp IgTalu MRI0] SLL pTTaTalal] 1009 .00000 Qccuepicd 1%
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While the plot is displayed on screen many of the hotkeys from the Plot

dialog box may still be used. This includes Alt+N to toggle point names on
and off, Alt+Y to toggle symbols on and oft, and so on. The following keys

can be used:

?

v

PgUp
PgDn
-

-

Sft+«

Sft+—

Ctl +<«

Ctl+-

Alt+N

Alt+Y

Alt+C

Alt+T

Alt+G

Escape

Move to previous point
Move to next point
Move back approximately 20 points
Move forward approximately 20 points

Zoom out fromcurrent point by factor of 50%
Zoomin on current point by factor of 50%

Zoom out from current point by factor of 5%

Zoomin on current point by factor of 5%
Zoom out from current point by factor of 500%
Zoomin on current point by factor of 500%
Toggles point names on/off

Toggles symbols on/off

Toggles Cogo linework on/off

Toggles Topo linework on/off

Toggles grid oft/tics/lines
Exits from the plot window

In addition the mouse can be clicked on a point to select that point as
the current point. If several points are within the search radius, repeatedly
clicking will cycle through all the points.
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To Output Plot to Device

Press Sft+F5 (the Plot function key) when you are ready to plot to

printer or plotter. A white box will be displayed on screen showing what area
will fit on the page at the current scale. While the page outline is displayed the

following keys can be used.

? I «<— The arrow keys are used to position the frame around the area
you wish to plot. To adjust the frame in fine increments, hold

down the Shift key while adjusting it.

Alt+L Rotates the plot frame to the left or counterclockwise. The
frame is rotated around the rotation point which is the lower
left corner of the frame, as it is first displayed. This is also

the corner where the scale and north arrow are displayed, so

you may wish to consider this when positioning your plot.

Alt+R Rotates the plot frame to the right or clockwise around the

rotation point.

Sft+F5 Press the Plot function key again when you have positioned
the frame properly, and the plot will be output to the device
you have selected.

Escape Aborts the windowing process and returns you to the previous
mode.

Plotting Templates

Templates may also be plotted. However only one template is plotted

at a time. Highlight the template which you wish to view and execute the Draw
File command. If you have defined separate cut and fill templates they will be
plotted in contrasting colors.
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Section 9.3. Draw Points

The Draw Points command allows you to specify a series of point
ranges which you wish to plot. Other than specifying the point ranges to be
plotted, it functions exactly like Draw File.

When youfirst execute the Draw Points command a dialog box with a

list box is displayed. Press Space to add a line to the list of ranges. You can
now enter a prefix, beginning number, and ending number to specify a point
range. Press Enter after inputting this data. You may continue to add ranges
in this same fashion. This range data will be preserved until you exit FileMan.
The Delete key can be used to delete a range.
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Section 10. Options Menu

The Options Menu provides several important functions. From here

you can change configuration data, display system information, or display
version information about FileMan.

Section 10.1. Configuration

The Configuration dialog box allows you to change various system

parameters.

When FileMan compares Cogo points you can control how the textis
treated. There are three possible choices. The text can be ignored, compared
with case sensitivity, or compared without case sensitivity.

Topo measurements can be displayed in three different formats. You
can select one of the following modes:

Hor. angle, Ver. angle, Slope distance
Hor. angle, Zen. angle, Slope distance
Hor. angle, Hor. dist. Ver. distance

When you delete a point FileMan asks if you are sure you want to
delete. If you are deleting a large number of points or find this inconvenient
you may disable this with the Confirm Deletion option.

If the Insert Zero Points option is disabled, only Cogo points which
contain data are inserted in the file when importing or reading from the HP48.
Enabling this option corresponds to the way previous versions of FileMan

operate.

With some older computers and video adapters writing to the screen can
take a significant amount of time. When FileMan transfers points to and from
the HP48, and through ASCIIfiles the points are echoed on screen as they are

transmitted or received. If you have an older computer you may find that

transfers run significantly faster with Echo Points disabled.

To facilitate use of the numeric keypad for data entry, FileMan
provides an option which allows you to use the Plus key (on the numeric keypad
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only) as a Tab key for moving fromfield to field. This optionis controlled by

the Keypad Plus=Tab option.

FileMan also includes a screensaver which is intended to protect your
monitor from the damage caused by images which remain stationary on the
screen for long periods of time. You can set the amount of time required before
the screensaver goes into effect. The screensaver can also be invoked by typing

Ctrl +]. The BGI directory must be set correctly in the Draw Setup dialog box
for the screensaver to work correctly.

Section 10.2. System Information

The System Information dialog box displays the DOS version you are
using, the amount of RAM installed and available, the amount of disk space
installed and available, and the coprocessor installed, if any. It is good practice
to keep an eye on these numbers because running out of disk space or RAM can

cause loss of data.

If you have made changes to a file but your disk is full FileMan will
be unable to save the data. If this should occur, you can invoke a DOS shell,

delete unneeded files, and return to FileMan to save your file. Another
alternative is to use the File Save As command to write the file to a floppy disk
or another hard drive on your system.

If you find that you do not have enough RAM available, there are
severalthings you can do. If you are using a DOS version earlier than 5.0 you
should consider upgrading. Also remove any unnecessary TSR programs from

memory. You can also use DOS 5.0 or third party memory managers to load

some TSR programs and drivers in high memory areas to free up more space
in the lower 640K of RAM. Another alternative is to reduce FileMan’s memory
consumption by decreasing the frames variable. By decreasing the number of
virtual memory frames to 50 you will free approximately 40K of RAM. This
will affect performance however, unless you use disk caching software. See the
advanced installation section for more details.
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Section 10.3. User Functions

The User Functions Menu allows you to install two DOS commands to

be readily executed from FileMan. These are provided to allow you to enter

commonly used commands such as command line utilities which you may use
to retrieve a file from a network database.

Enter the command exactly as you would at the DOS prompt and then
you will be able to run the command at any time just by executing the Options
User Function command. Press the appropriate button to run the command

which you have entered. After the command executes, FileMan will prompt you
to press any key. This allows you to view output from the program.

Space for two functions is provided so that you may use one for
importing data and one for exporting data.

For additional information on running commands in a DOS subshell see
the DOS Shell section.

Section 10.4. About FileMan

The About FileMan command provides information about the program
and the installation. This shows what version of the program you are using
(something which you should check before contacting us for technical support),
who the software is registered to, and the serial number of the software.
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Section 11. Window Menu

The Window menu provides commands for arranging the file windows

and other window types on screen. Note that all these commands have shortcut

keys which are displayed in the menus and on the FileMan overlay.

Section 11.1. Zoom Window

The Zoom Window command allows you to enlarge the current window
to fill the entire desktop. The small icon on the upper right hand corner of the
window frame also performs this function. When the window is Zoomed,

executing the Zoom command again reduces the window to its default size.

Section 11.2. Next Window

When you have more than one file open on the desktop, it may become
necessary to switch from one to another. The Window Next command allows

you to move from one window to another when multiple file windows are open
on the desktop. The command cycles through the windows in the order in
which they were opened. The F6 key also performs this function.

Another way to switch files is by clicking the mouse on the window you
wish to select (since the windows are cascaded diagonally there will always be
at least one corner exposed).

You will also notice that each file window has a number on the top
border. You can select a particular window by pressing Alt+N where N is the
number of the window you wish to select.

Section 11.3. Previous Window

Use the Window Previous command to cycle backwards through the
windows on the desktop. The Shift + F6 key also performs this function.
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Section 11.4. Move Window

The Window Move command allows you to rearrange the windows on

your desktop with the cursor keys. If you have a mouse, see the section on

mouse use for an alternative method.

After executing the File Move command you will notice that the status
line at the bottomofthe screen has changed. All other operation of the program

is suspended until you finish the task of moving the current window. Use the
four cursor control keys to position the window where you want it. Press Enter

when finished, or Escape to cancel.
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Section 12. Keyboard Macros

A macro is a series of keystrokes which are saved and then ’replayed’

at the users command. FileMan allows you to create macros which contain up

to 128 keystrokes and bind these to a key on the keyboard.

A macro may be bound to any key on the keyboard other than Enter,
Escape, and the arrow keys. Care should be used to ensure that the key you

choose to bind a macro to will not be needed in other circumstances. For
example, the Alt key is used in combination with many letters and numbers in
various dialog boxes so we recommend that you avoid binding macros to Alt key
combinations other than the function keys. There are a variety of other function
key combinations which are not used and macros may also be attached to these
keys. The Ctl key is rarely used by FileMan so it is a good choice, and it may
be used in combination with both the alphabet keys and the function keys.

A macro may contain any keystrokes, whether they have special

meaning to FileManor not. When the macro is invoked it functions exactly as
if you were typing the keys on the keyboard. This means that keys which are

not defined in a particular mode are ignored.

Macros must be used with caution. A macro which is designed to do
some series of commands may have entirely different results when invoked
under different circumstances.

When executing commands from the menus you should use the
highlighted characters rather than scrolling with the cursor keys. This is
because each time you enter a menu, the cursor could be at a different location.

If you enter a key which has a macro attached into the definition of a
new macro the macro will not be expanded or invoked. This differs from
previous versions of FileMan.

Macros are defined by recording. To begin recording a macro press

Ctl+F10. A single beep will sound and the status line will prompt you to press
a key. Now press the key you wish to bind the macro to. This may be any key
( including Shift, Control, and Alt key combinations ) on the keyboard. It is
recommended that you use Control in combination with any letters you use to

avoid conflicts with the various Alt key combinations used by FileMan. When

you press a valid key two beeps will sound, the status line will display
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"Recording Macro’ and you may begin recording your macro. Follow the exact

steps you wish the macro to perform. When you are finished press Ctl + F10

again and two more beeps will sound indicating that the macro has been

recorded.

To clear a macro press Ctl+F10. Now press the key you wish to
clear. Two beeps will sound as before. Press Ctl+F10 immediately and any
macro previously attached to the key will be removed.

Here are several sample macros that you may find useful.

Key Commands Notes

Ctl +C Space Tab 0 Clears a Cogo Point
Tab 0 Tab 0
Tab Del Enter
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Notes
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